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Quick Access
This section shows a roadmap for the installation of the IT Business Analytics application.

Plan the Installation

Business Analytics Components

Licensing

Deployment Solutions

Prerequisites

About the Installation

Install the Vertica Database

Do you want to be able to display BO reports in the ITBA application?

Yes

No
Optional - Install BOE on a

Linux Server
Optional - Install Client BOE onWindows

Optional - Install the Vertica Driver in the BOE Server and the BOE Client
Server

Install the DBeaver Tool

What type of installation do you want to perform?

Silent Installation Console Installation GUI Installation

Install the Supervisor After the Installation

Configure the Linux Port

How to Use Your OwnCertificate?

Installation Logs

Uninstall ITBA
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Plan the Installation
Before you begin your deployment of IT Business Analytics, you should:

l Understand the components of the application. For more information, see "Business Analytics
Components" on page 8

l Decide which type of IT Business Analytics licensing you are implementing, and if necessary
purchase the relevant license key file. For more information, see "Licensing" on page 9.

l Decide whether your deployment will be for Development, Test, or Proof-of-Concept (POC), or
Production environments. For more information, see "Deployment Solutions" on page 11.

l Decide if you want to work with SAP Business Objects Enterprise.

l Ensure that your hardware and softwaremeet the system requirements.

The environments supported by IT Business Analytics are described in the Support Matrix
document available from the Support Site
(https://softwaresupport.hpe.com/group/softwaresupport/ or from the Installation DVD).

l Ensure that you have reviewed the Installation checklists section. The section provides database
naming and password limitations that could cause the installation to fail.

Limitation: Do not use the following characters in any of the directory names specified during the
ITBA  installation procedures: % ^ & < > | ' ` , ; = ( ) ! \ [ ] "

The ITBA 10.10 installation bundle package includes the following:

l Documentation

l Open_Source_and_Third_Party

l ITBA-10.10-Redhat-X64-bin.tar.gz

l ITBA-10.10-Ubuntu-X64-bin.tar.gz

l ITBA-10.10-IDE.zip

l Vertica-7.1.2-4_amd64.zip

l Vertica-7.1.2-4-x86_64.RHEL5.zip

l BOE-4.1-SP3-Client_Windows.zip

l BOE-4.1-SP3-Server_Windows.zip
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l BOE-4.1-SP3-Server upgrade_Windows.zip

l BOE-4.1-SP2-Dashboard_Win32.zip

l BOE-4.1-SP3-Client_Windows.zip

l BOE-4.1-SP3-Server_Linux.zip

l BOE-4.1-SP3-Server upgrade_Linux.zip

l BOE-4.1-SP2-Dashboard_Win32.zip

Installation Guide
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Business Analytics Components
Business Analytics includes the following components:

l Business Analytics Application - Provides themeans to define IT goals and objectives, to
measure performance, and provides actionable insights into performance improvement plans. It
includes the Dashboard, Studio, Explorer, Admin, and DataWarehouse (DWH) modules.

DWH is a repository for key business data that is cleansed, consolidated, and organized to support
efficient queries, reports, and to populate a variety of business analytics. The contents of the Data
Warehouse depend on the external HP applications that generate business data. For example, the
datamay originate from external applications such as Application Lifecycle Management or Project
and Portfolio Management.

l Optional - SAP BusinessObjects Enterprise (BOE) - A solution that provides reporting, analysis
and information delivery via web applications. This component is optional. SAP BusinessObjects
Enterprisemust be installed separately.

Youmust install BOE if you plan to use:

o The CSA-related pages in the Dashboard.

o TheWeb Intelligence Report Viewer andWeb Intelligence Static Report in the Dashboard. For
details, see TheWeb Intelligence Report Viewer Component or TheWeb Intelligence Static
Report Viewer Component in theBusiness Analyst Guide.

l Common components - foundations on which the IT Business Analytics deployment is built.
Common components are automatically installed on servers when you install ITBA.

Other critical external components include:

l Vertica - An analytics database that handles big data from our source system and relevant
information.

l Source Application Servers - Source data originates in external application repositories. Data
Warehouse consolidates the data from one or more of these external application repositories, and
makes it available for analysis by Business Analytics.

HPE IT Business Analytics (10.10) Page 8 of 138



Licensing
The HP License Key Delivery Service web site (webware.hp.com)manages HP software licensing for
the IT Business Analytics application. You can view or download the latest version of the ESD and
Webware LicenseManagement Guide from this site. The guide describes the current process to obtain
your entitlement certificate, which contains the HP order number that you need to generate your
permanent license keys.

Follow the steps in the ESD andWebware LicenseManagement Guide to present your HP order
number, select the products that need licenses, and provide other required information.

If you are a first time visitor to the web site, you will be asked to create an account with an email
address and password. Most requests to generate permanent license keys require the following:

l IT Business Analytics product name and number shown on the product receipt or in the email sent
by HP to acknowledge the order.

l The order number from the entitlement certificate.

l A target server name and IP address.

l Contact information, such as company name, your name, fax and phone numbers, and license
ownership details.

If necessary, you can return to the HP License Key Delivery Service web site and retrieve the
permanent or temporary license keys again by selectingManage Licenses on the web site home page
and logging into your account.

If you have an existing SAP BusinessObjects Enterprise installation, you can use that instance. If you
purchase SAP BusinessObjects Enterprise with HP IT Business Analytics, the purchase includes the
required licenses.

Other applications that generate or use data, require separate licenses.

Permanent License Keys

After you create your user account on the HP License Key Delivery Service web site
(webware.hp.com), generate the entitlement certificate, and generate the license keys, the License
Key Delivery Service sends permanent keys to you in an email text file attachment. You load
permanent license key files during the installation configuration. When a permanent IT Business
Analytics license covering the components you are installing is loaded, details of the license are
recorded to theManagement database and there is no further requirement for loading the license when
installing each component.
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Temporary License Keys

A temporary license for 60 days is automatically generated during the installation procedure.
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Deployment Solutions
IT Business Analytics is made up of various components, such as DataWarehouse and ITBA. SAP
BusinessObjects Enterprise is optional.

Verticamust be installed before you install IT Business Analytics. In addition, the data sources must
be installed on separate servers. The Target Scheme, Application Scheme, and Extension Scheme are
all part of Vertica.

SAP BusinessObjects Enterprise is optional and can be installed at any time.

Depending on the purpose of your installation, you can use one of the deployment solutions described
below:

l 2 servers.

o IT Business Analytics (Data
Warehouse and ITBA components)
 on one server

o Vertica on one server

o Optional: SAP BusinessObjects
Enterprise on another server

The configuration purpose is:
Production

l 4 servers.

o IT Business Analytics (Data
Warehouse and ITBA components)
 on one server

o Vertica in cluster format on three
servers

o Optional: SAP BusinessObjects
Enterprise on another server

The configuration purpose is:
Production
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Prerequisites
Before you start the installation check the following prerequisites.

Fully Qualified Domain Name (FQDN) settings

Set the FQDN on both the ITBA server and the Vertica server:

1. As root user, update the /etc/hosts file with the server FQDN.

2. Edit:

o The /etc/sysconfig/network file andmodify theHOSTNAME=<FQDN> for the Redhat or
CentOS systems.

o The /etc/hostname file and add theSERVERNAME for the Ubuntu system.

Example: The FQDNs for ITBA server and Vertica server are:

o hostname=itba.hpdemo.com

o hostname=vertica.hpdemo.com

3. Reboot the server.

Licenses

During the Business Analytics configuration, you are required to enter the application license details.

About the Installation
Make sure you install the following components in the order below:

1. Vertica - For details, see "Install the Vertica Database" on page 14.

2. BOE (Optional) - Install BOE if you want to view BO reports. For details, see "Optional - Install
BOE on a Linux Server" on page 16 or "Optional - Install BOE Client onWindows Server" on page
33. Then youmust install the Vertica driver in the BOE server. For details, see"Optional - Install
the Vertica Driver in the BOE Server and the BOE Client Server" on page 39.

3. ITBA - Select the relevant installationmethod:

o Silent Installation - For details, see "Silent Installation" on page 43.
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o Console Installation - For details, see "Console Installation" on page 50.

o GUI Installation - For details, see "GUI Installation " on page 70.

Installation Guide
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Install the Vertica Database
To install the Vertica database on the Vertica server, proceed as follows:

Note: The following steps can be used to install Vertica on a single server. The steps are not
recommended for a production environment. To install Vertica onmultiple servers, or to tune
cluster and performance, refer to HP_Vertica_7.1.x_Install_Guide.pdf at
https://my.vertica.com/docs/7.1.x/PDF/HP_Vertica_7.1.x_Install_Guide.pdf or
https://softwaresupport.hpe.com/km/KM00681120 (7.0)

1. Install all necessary service packs and packages for your operating system.

2. Install Vertica:

a. Get the RPM installer from the ITBA binary delivery.

b. Switch to the root user.

c. Install RPM using the following commands:

i. rpm -ivh vertica-7.1.2-4.x86_64.RHEL5.rpm

ii. /opt/vertica/sbin/install_vertica -s localhost -r vertica-7.1.2-4.x86_64.RHEL5.rpm -
u <dba_user_name> -p <dba_user_password> -L <license file name> --failure-
threshold FAIL –Y.

where <dba_user_name> is the user name of the DBA Administrator and <dba_user_
password> is the password of the DBA Administrator, and <license file name> is the file
name of the Vertica license.

If the install_vertica command fails for one of the reasons shown below, access the
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corresponding link to correct the issue, and then rerun the command after the configuration.

3. Switch to the DBA user you created in the previous step.

4. Create a database for ITBA using the following command:

/opt/vertica/bin/admintools -t create_db -s localhost -d <database_name> -p <dba_user_
password>

where <database name> is the name of the Vertica database and <dba_user_password> is the
password of the DBA Administrator.

Vertica is now installed.

Installation Guide
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Optional - Install BOE on a Linux Server
This section describes how to install BOE on a Linux Server.

If you want to work with BOE, install it on a separate server.

Note: To get a license for BOE, contact HP Software Support Online web site at:
https://softwaresupport.hpe.com.

1. Prerequisites:

o Only 64-bit Operating systems are supported.

o Make sure the installation target has adequate disk space ~20GB ormore (It might require
additional space for applying patches and Service Packs (SPs)).

o Make sure you have enough space (~2GB) for the temporary file system.

o Create a user account and a group under which the supported SAP BusinessObjects
Enterprisesoftware will run. This account does not require root privileges.

o Locale: Configure a supported UTF-8 locale by setting the LC_ALL and LANG environment
variables.

Example:

export LANG=en_US.utf8

export LC_ALL=en_US.utf8

o Unlimit settings must be set to unlimited by using the unlimit command or by editing
/etc/security/limits.confmanually. Make sure themax user processes of the BOE user is
4096 at least.

o Read, write and execute permissions must be set for the installation target destination
directory.

2. Prerequisites - Red Hat libraries:

Before installing on Red Hat Linux, youmust ensure that all the required libraries are installed.
Ensure you have root access, then use the Yum software installation tool to run the following
commands:

yum install libXext

yum install libXext.i686
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yum install compat-libstdc++-33.i686

yum install compat-libstdc++-296.i686

yum install compat-libstdc++-33

yum install libstdc++.i686

yum install libstdc++

yum install libX11.i686

yum install libXext-devel.i686

yum install libXext-devel

Tip: If you get an error while running yum install libstdc++.i686, run yum update libstdc++
first and then run yum install libstdc++.i686 again

3. Check the prerequisites:

To check if these libraries are installed use the following commands:

4. Unzip the BOE installation package:

Installation Guide
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a. Add the executive attribute for the bit folder.

Example: chmod +x -R 51047840

b. Go to <installation BOE folder>/DATA_UNITS/BusinessObjectsServer_lnx/

c. Run the setup: ./setup.sh to start the BOE installation console.

For example:

5.

Installation Guide
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6. Click Enter.

7. Click Enter.

Installation Guide
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8. Click Enter to accept.

9. Enter the product key and click Enter.

Installation Guide
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10. Select the relevant language of the BOE application and click Enter.

11. Select 1 - Full and click Enter.

Installation Guide
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12. Select 1 - Configure and install a Sybase SQL Anywhere database and click Enter.

13. Select 1 - Install the default Tomcat Java Web Application Server and automatically
deploy web applications and click Enter.
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14. Select 1 - Configure and install Subversion and click Enter.

15. Configure the Server Intelligence Agent (SIA) by entering the relevant information and click Enter.
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16. Configure the Central Management Server (CMS) by entering the relevant information and click
Enter.

17. Configure the CMS Account by entering the relevant information and click Enter.

Installation Guide
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18. Configure Sybase SQL Anywhere by entering the relevant information and click Enter.

19. Configure Tomcat by entering the relevant information and click Enter.

Installation Guide
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20. Configure HTTP Listening Port by entering the relevant information and click Enter.

21. Configure Subversion by entering the relevant information and click Enter.

Installation Guide
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22. Select 1 - Do not configure connectivity to SMD Agent and click Enter.

23. Select 1 - Do not configure connectivity to Introscope Enterprise Manager and click Enter.

Installation Guide
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24. Click Enter to install.
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25.

26. Launch BOE:

Note: To have your servers start automatically when the host machine is started or stopped,
run the following script as the root user:
<installation BOE folder>/sap_bobj/init/setupinit.sh

Enter: http://BI41RH6:8080/BOE/CMC

Account: Administrator

Installation Guide
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Password: ********
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Download the shared secret

Youmust first download the shared secret that will be used during the ITBA installation.

1. Log on to the BOCentral Management Console (CMC).

2. Click Authentication > Enterprise, check the Trusted Authentication is enabled option, and
click Update.

3. Click Download Shared Secret to download secret file.

Installation Guide
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Optional - Install BOE Client on Windows Server
This section describes how to install BOE Client on aWindows environment.

Install the BOE Client on Windows

1. Download the supported SAP BusinessObjects Enterprise Client Installation.

2. Unzip the SAP BusinessObjects Enterprise Client package.

3. Go to the following folder:

<BOE-Client_folder>\bip_4.1sp3_client\SBOP_BI_PLAT_4.1_SP3_CLNT_WIN_32_64B_
\DATA_UNITS\BusinessObjectsClient

4. Click setup.exe.

For example:
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5. Click Next.
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6. Accept the license agreement.
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7. Click Next to start the installation.
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8. Wait for the installation to complete.
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The installation completes. Click Finish.

BOE Client is now installed.
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Optional - Install the Vertica Driver in the BOE Server and
the BOE Client Server
If you work with BOE, youmust install the Vertica Driver in the BOE Server (Windows/Linux) and in the
BOE Client Server.

Install the Vertica Driver in the BOE Server

1. Get the Vertica JDBC driver from ITBA in the following directory:

$HPBA_HOME/glassfish/glassfish/domains/BTOA/lib/vertica-jdbc-7.1.1-0.jar

2. Copy the driver to the following location in the BOE server:

BOE on aWindows Server:
[BO_INSTALLATION_DIRECTORY]\SAP BusinessObjects Enterprise XI
4.0\dataAccess\connectionServer\jdbc\

BOE on a Linux Server:
[BO_INSTALLATION_DIRECTORY]/sap_bobj/enterprise_
xi40/dataAccess/connectionServer/jdbc/

3. Open the following file:

BOE on aWindow Server:
[BO_INSTALLATION_DIRECTORY]\SAP BusinessObjects Enterprise XI
4.0\dataAccess\connectionServer\jdbc\vertica.sbo

BOE on a Linux Server:
[BO_INSTALLATION_DIRECTORY]/sap_bobj/enterprise_
xi40/dataAccess/connectionServer/jdbc/ vertica.sbo

4. Update the driver locations in vertica.sbo as below:

Example on aWindows Server:
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Example on a Linux Server:

5. Restart Tomcat and SIA in the Central ConfigurationManager:

o BOE on aWindows server:

o For Linux Server, Execute the scripts listed below:

cd [BO_INSTALLATION_DIRECTORY]/sap_bobj

./stopservers

./tomcatshutdown.sh

./startservers

./tomcatstartup.sh

6. The procedure is complete.
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Install the Vertica Driver in the BOE Client Server

1. Get the Vertica JDBC driver from ITBA server in the following directory:

$HPBA_HOME/glassfish/glassfish/domains/BTOA/lib/vertica-jdbc-7.1.1-0.jar

2. Copy the driver to the following location in the BOE client server:

[BO_INSTALLATION_DIRECTORY]\SAP BusinessObjects Enterprise XI
4.0\dataAccess\connectionServer\jdbc\

3. Open the following file:

[BO_INSTALLATION_DIRECTORY]\SAP BusinessObjects Enterprise XI
4.0\dataAccess\connectionServer\jdbc\vertica.sbo

4. Update the driver locations in vertica.sbo as below:

Example on aWindows Server:

Installation Guide
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Install the DBeaver Tool
Tomanage the Vertica database, download and then install the DBeaver client tool from the following
location: http://dbeaver.jkiss.org.
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Silent Installation
You can install ITBA using a silent installation (see below), a console installation, or a GUI installation.

Install ITBA using a silent installation

Important:Save the values of the parameters in this page. TheGlassfish Administrator password is
also used to log on to the ITBA Maintenance tool. The Application authentication password is also used
as your ITBA logon credentials.

To install ITBA using the silent installation, proceed as follows:

1. Create a user or use an existing user. Make sure you are not using the root user to perform the
installation.

2. Log on to the Linux server where you want to install ITBA.

3. Download the ITBA-10.10.XXX.tar.gz file from the Support Site
(https://softwaresupport.hpe.com/group/softwaresupport/home?lang=en-US) and save it in your
Linux target directory. Make sure the installation target directory has adequate disk space. For
details, seeSupport Matrix.

Make sure that the path to the target directory does not include blank spaces, brackets (or), or
single quotes (').

4. Run the tar -zxvf ITBA-10.10.XXX.tar.gz command to unzip the ITBA-10.10.XXX.tar.gz file.

5. Go to the Linux user path directory where you unzipped the installation file, and run ./install.sh -a
or sh install.sh -a to generate the answer file.

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<config>

<section name="PreCheck" description="This section is responsible for
filling in the pre-condition values">

<field id="install.PRODUCT_AGREEMENT" description="Use 'Yes' to accept
the product announcement. Otherwise, use 'No'. 'No' aborts the installation">

<name>ProductAgreement</name>
<value>Yes</value>

</field>
<field id="install.LICENSE_IS_EVALUATION" description="The product

license type. Use 'true' when you don't have a valid license and you want to
get an evaluation license. Use 'false' to load your Power Named User License or
to use a temporary license">
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<name>productTypeFlag</name>
<value>true</value>

</field>
<field id="install.LICENSE_POWERUSER_FILE_PATH" description="The path

to the license file of the power user for the installation. It only take effect
only if LICENSE_IS_EVALUATION is 'false'">

<name>LicenseFilePathOfPowerUser</name>
<value></value>

</field>
<field id="install.LICENSE_VIEWER_FILE_PATH" description="The path to

the viewer license file. Note that your Power User license must be valid. It
only take effect only if LICENSE_IS_EVALUATION is 'false'">

<name>LicenseFilePathOfViewer</name>
<value></value>

</field>
</section>
<section name="DWH" description="This section is responsible for filling in

the property values for DWH">
<field id="bo.cms.import.xs.license" description="To import the XS

license to SAP BOE use 'true'. Otherwise, use 'false'">
<name>importBALicenseToSAPBOE</name>
<value>false</value>

</field>
<field id="bo.engine.is.installed" description="If BOE is installed,

input 'true'. Otherwise, input 'false'. Note: only BOE version BOE4.0SP6 or
later is currently supported">

<name>boe install status</name>
<value>false</value>

</field>
<field id="bo.engine.logon.auth.type" description="Indicates the BOE

logon auth type:
[secEnterprise,secLDAP,secWinAD,secSAPR3,secPSE1,secOraApps,secpsenterprise,sec
Siebel7]">

<name>boe logon auth type</name>
<value>secEnterprise</value>

</field>
<field id="bo.cms.host.name" description="The name of the BOE server on

which the that you want to connect with is installed">
<name>boe HostName</name>
<value></value>

</field>
<field id="bo.cms.host.port" description="The port number of the CMS

listener">
<name>boe port</name>
<value></value>

</field>
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<field id="bo.cms.sso.shared.secret" description="The path to the file
that contains BOE shared secret">

<name>boe shared secret</name>
<value></value>

</field>
<field id="bo.cms.admin.userName" description="The user name for the

SAP BusinessObjects Enterprise administrator">
<name>boe username</name>
<value></value>

</field>
<field id="bo.cms.admin.user.pw" description="The password of the BOE

admin user">
<name>boe password</name>
<value></value>

</field>
<field id="bo.cms.opendoc.port" description="The BOE Tomcat port used

to display the BOE reports in Scorecard (usually 8080)">
<name>Tomcat port</name>
<value></value>

</field>
<field id="install.dwh.HOST_NAME" description="The DWH server host

name">
<name>HostName</name>
<value>HostName</value>

</field>
<field id="install.dwh.PORT" description="The DWH server port number">

<name>Port</name>
<value>5433</value>

</field>
<field id="install.dwh.DATABASE_NAME" description="The name of the

Vertica database instance that is used as the data warehouse">
<name>VerticalDatabaseName</name>
<value>xsvertica</value>

</field>
<field id="install.dwh.LOGIN_NAME" description="The DWH logon name

which should have schema creation permissions">
<name>LoginName</name>
<value>vertica</value>

</field>
<field id="install.dwh.PASSWORD" description="The DWH password name">

<name>Password</name>
<value></value>

</field>
<field id="install.dwh.SOURCE_STAGING_SCHEMA_NAME" description="The

source staging schema name of the DWH">
<name>SourceStagingSchemaName</name>
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<value>dws</value>
</field>
<field id="install.dwh.TARGET_STAGING_SCHEMA_NAME" description="The

target staging schema name of the DWH">
<name>TargetStagingSchemaName</name>
<value>dwst</value>

</field>
<field id="install.dwh.TARGET_SCHEMA_NAME" description="The target

schema name of the DWH">
<name>TargetSchemaName</name>
<value>dwt</value>

</field>
<field id="install.dwh.RESULT_SCHEMA_NAME" description="The result

schema name of the historical result">
<name>ResultSchemaName</name>
<value>dbo</value>

</field>
<field id="install.dwh.EXTENSION_SCHEMA_NAME" description="The

extension schema name of the imported external xls,xlxs,and csv tables">
<name>ExtensionSchemaName</name>
<value>ext</value>

</field>
<field id="install.dwh.APPLICATION_SCHEMA_NAME" description="The

application schema name of the DWH">
<name>ApplicationSchemaName</name>
<value>BA</value>

</field>
<field id="install.dwh.TIMEZONE" description="The timezone value. Use

the international standard TimeZone name">
<name>AppTimeZone</name>
<value>Asia/Shanghai</value>

</field>
<field id="install.dwh.CURRENCY" description="The default currency for

DWH. Use the standard of ISO 4217">
<name>currency</name>
<value>USD</value>

</field>
<field id="install.dwh.period_dim.FIRST_YEAR" description="The first

year for the initial period dimension loading">
<name>FirstYear</name>
<value>2005</value>

</field>
<field id="install.dwh.period_dim.LAST_YEAR" description="The last year

for the initial period dimension loading">
<name>LastYear</name>
<value>2025</value>
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</field>
<field id="install.dwh.period_dim.FIRST_DAY_OF_WEEK" description="The

first day of week.[Sunday,Monday,Tuesday,Wednesday,Thursday,Friday,Saturday]">
<name>FirstDayOfWeek</name>
<value>Monday</value>

</field>
<field id="install.dwh.period_dim.FISCAL_YEAR_START_MONTH"

description="The fiscal month offset for the initial period dimension loading.
Use the 1-12 format">

<name>FiscalYearStartMonth</name>
<value>1</value>

</field>
</section>
<section name="Application" description="This section is responsible for

filling in the property values for the application">
<field id="install.app.webserver.HTTP_PORT" description="The http port

number for the web server">
<name>HttpPort</name>
<value>2024</value>

</field>
<field id="install.app.webserver.HTTPS_PORT" description="The https

port number for the web server">
<name>HttpsPort</name>
<value>8443</value>

</field>
<field id="install.app.xs.USER_NAME" description="The user name for the

administrator. Use this user to log on to IT Business Analytics for the first
time">

<name>UserName</name>
<value>administrator</value>

</field>
<field id="install.app.xs.PASSWORD" description="This password that is

used only to log on to BA">
<name>Password</name>
<value>Admin111</value>

</field>
<field id="install.app.glassfish.PASSWORD" description="The password to

log on to the Glassfish admin console">
<name>Password</name>
<value>Admin111</value>

</field>
<field id="USAGE_TRACKING_SETTINGS" description="Use Usage Hub to track

license usage or not">
<name>UsageTrackingSettings</name>
<value>true</value>

</field>
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<field id="USAGE_HUB_URL" description="Usage Hub Host/IP">
<name>Usage_Hub_Host</name>
<value>16.155.197.49</value>

</field>
</section>

</config>

Enter the relevant values in the answer file.

Note: First day of the week

In DataWarehouse, the first day of the week is set during the installation, and the Period tool
is using it as an input to build PERIOD_DIM days, weeks, months, andmore, as well as
relevant hierarchies.

After the administrator has installed DataWarehouse, the administrator selects the
designated first-day-of-week. If a data source has a different first-day-of-week definition, the
administrator should be aware that for weekly periodicity, the linkage to the period key uses
the DataWarehouse week definition and not the data source week definition.

For details about currency, see "Currency" on page 113.

For details about the time zone, see "Time Zones" on page 116.

6. Run./install.sh -s or sh install.sh -s.

Tip: Make sure to install the Supervisor. For details, see "Install the Supervisor After the
Installation" on page 96
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In Case of Failure of Silent Installation or Other Errors

If the silent installation fails or some unexpected error happens, such as reboot, power off and others,
make sure to delete the <ITBA Target Directory>/ba-answer.xml file.
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Console Installation

Prerequisites

1. Create a user or use an existing user.

Note: Make sure you are not using the root user to perform the installation.

2. Log on to the Linux server where you want to install ITBA.

3. Download the ITBA-10.10.XXX.tar.gz file from the Support Site
(https://softwaresupport.hpe.com/group/softwaresupport/home?lang=en-US) and save it to your
Linux target directory.

Note: Make sure the installation target directory has adequate disk space. For details, see
Support Matrix.

Note: Make sure that the path to the target directory does not include blank spaces, brackets
(or), or single quotes (').

4. Run the tar -zxvf ITBA-10.10.XXX.tar.gz command to unzip the ITBA-10.10.XXX.tar.gz file.

Note: Panels that show <H>elp can provide online help for the fields displayed in the panel. Enter
h to display the information.
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Introduction

Tip: After you enter an answer or select a number as stated below in the console installation
sections, youmust click Enter to execute the answer or the option.

1. When the unzipping is complete, go to the <ITBA Target directory> and run the ./install.sh -c or
sh install.sh -c command to start the console installation. The following panel is displayed.

2. Enter n.
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License Agreement

1. The License Agreement panel is displayed.

2. Enter h to read the user license agreement.

3. Then:

o Enter 1 and answer y to accept the agreement. Then enter n to go to the next panel: "Enter the
Vertica Database Server Details" on page 54.
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o Enter 1 and answer n to refuse the agreement. You are not allowed to continue the
ITBA installation. Click Ctrl+C to exit the installation process.
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Enter the Vertica Database Server Details

1. The Enter DB Details panel is displayed, where you can enter the Vertica Database server details.

2. Enter the relevant field number, answer the request with the relevant value.
Proceed through all the fields, and then enter n.

Host
Name

The IP address of the server hosting the Vertica database.

To configure Vertica load balancing, see the section “Connection Load Balancing”
in the Vertica Administrator’s guide at
https://my.vertica.com/docs/7.1.x/PDF/HP_Vertica_7.1.x_
AdministratorsGuide.pdf.

Port The port of the server listener. Change this value to connect to a non-default
database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site
(https://softwaresupport.hp.com/group/softwaresupport/home) .

Database
Name

The name of the Vertica database instance that is used as the data warehouse.

Make a note of the Vertica database name as youmay need it when installing
other components.

For details, see Database Naming Conventions.

Login
Name

The name of the user used to log on to the Vertica database.

Password The password of user used to log on to the Vertica database.
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Enter the Database Scheme Names

1. The Enter DB Details panel is displayed, where you can enter the Vertica Database server details.

By default, the fields already include the default names. You can enter your own values or keep
the defaults.

2. Enter the relevant field number and answer the request with the relevant value.
Proceed through all the fields, and then enter n.

Source Staging Scheme name The name of the source staging scheme.

Default: dws

Target Staging Scheme name The name of the target staging scheme.

Default: dwst

Target Scheme name The name of the target scheme.

Default: dwt

Application Scheme name The name of the application scheme.

Default: BA

Result Scheme name The name of the result scheme.

Default: dbo

Extension Scheme name The name of the extension scheme.

Default: ext
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Load Your License

1. The Choose License panel is displayed, where you can load a Power NamedUser License, a
temporary license, or an evaluation license.

2. Then:

o To get an evaluation license, select 1, enter true, and then enter n. You get to the "Enter the
SAP BOE Server Settings" on page 58.

An evaluation license is valid for 60 days. The remaining valid period of the license is
displayed.

o To get a Power NamedUser License or a temporary license, select 1, enter false, and enter n.

The Load a Power NamedUser License or temporary license panel opens.

i. Then, enter 1, enter the Power NamedUser License or temporary license absolute path,
and then enter n.

A Power NamedUser License has no expiry date and is loaded once during the
installation.

A Temporary license has an expiry date. On expiration, a new licensemust be loaded.

ii. Optionally, if you want to have a Viewer license:
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l To input the license path, enter 1, enter the Viewer license absolute path, and then
enter n.

l If you do not want to use a Viewer License, enter 1, click Enter, and then enter n.
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Enter the SAP BOE Server Settings

1. The Integrate BOE panel is displayed.

o Select 1, enter false, and enter n if you do not need to connect to BOE at this time. You get to
"Enter the Application\DWH Configuration Details " on page 61.

o Select 1, enter true, and n if you want to integrate with an existing BOE server.

Enter the relevant field number and answer the request with the relevant value.
Proceed through all the fields, and then enter n.

Connect to an
existing
SAP BusinessObjects
Enterprise server

Select to connect to an existing SAP BusinessObjects Enterprise
server.

Note: Only specific SAP BOE versions are supported. For details,
see the Support Matrix.

The Support Matrix is available from the Support Site (
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https://softwaresupport.hp.com/group/softwaresupport/home
).

BOE Server name The name of the server on which is located the SAP
BusinessObjects Enterprise that you want to connect with
Business Analytics is installed.

CMS Port The port number of the CMS listener (usually 6400).

For more information about ports, see the Support Matrix
document available from the Support Site (
https://softwaresupport.hp.com/group/softwaresupport/home
).

Administrator User
Name

The user name for the SAP BusinessObjects Enterprise
administrator.

Use this user to log on to SAP BusinessObjects Enterprise.

Administration
Password

The SAP BusinessObjects Enterprise Administrator password.
This password is used only to log on to SAP BusinessObjects
Enterprise.

This password is used only to log on to SAP Business Object
Enterprise.

SSO Shared Secret The path to the file that includes the SSO shared secret password.
The shared secret password is used to authenticate
communications with the SAP BusinessObjects BI platform or
later server. If trusted authentication is configured, the shared
secret entered is validated against the SAP BusinessObjects
server. If trusted authentication is not configured, the entered
shared secret is configured on the SAP BusinessObjects BI
platform server.

Authentication
scheme

secEnterprise. The default authenticationmethod for the SAP
BusinessObjects BI platform. It is automatically enabled when
you first install the system, and it cannot be disabled. When you
add andmanage users and groups, the platform maintains the user
and group information within its database.

If you prefer to create distinct accounts and groups for use with the
BI platform, or if you have not already set up a hierarchy of users
and groups in a third-party directory server, you have to do it
manually.

Tomcat port The BOE Tomcat port used to display the BOE reports in
Scorecard (usually 8080). For more information about ports, see
the Support Matrix document.

The Support Matrix is available from the Support Site (
https://softwaresupport.hp.com/group/softwaresupport/home
).

Import BA license to Select to import the license to SAP BOE used by ITBA.
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SAP BOE
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Enter the Application\DWH Configuration Details

1. The Application\DWH Configuration Details panel is displayed.

2. Enter the relevant field number and answer the request with the relevant value.
Proceed through all the fields, and then enter n.

Period
Dimension

First Year. The first year in the period dimension is the first year used when
automatically populating DataWarehouse tables with yearly, quarterly,
monthly, weekly and daily records. Only 1900-2099 is supported.

Change the First Year value by clicking the up or down arrows.

Last Year. The last year in the period dimension is the last year used when
automatically populating DataWarehouse tables with yearly, quarterly,
monthly, weekly and daily records. Only 1900-2099 is supported.

Change the Last Year value by clicking the up or down arrows.

Note: The Last Year must not be earlier than the current year.

For more information, see Settings - DataWarehousein theAdministrator
Guide.

First fiscal month of the year. The first fiscal month of the year in your
organization.

First day of the week. The day of the week you want to set as the first day.
Select: Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, or
Saturday. The field is not case-sensitive.
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Note: First day of the week

In DataWarehouse, the first day of the week is set during the installation,
and the Period tool is using it as an input to build PERIOD_DIM days,
weeks, months, andmore, as well as relevant hierarchies.

After the administrator has installed DataWarehouse, the administrator
selects the designated first-day-of-week. If a data source has a different
first-day-of-week definition, the administrator should be aware that for
weekly periodicity, the linkage to the period key uses the Data
Warehouse week definition and not the data source week definition.

Data related
configuration:

Time Zone. The DataWarehouse time zone used when consolidating the
data extracted from the data sources.

For details about the time zones, see "Time Zones" on page 116.

Web Server
configuration:

o The port of the HTTP listener. Select a Linux port number between 1024
and 65534.

Note: If you want to use the default HTTP port in the Business Analytics
installation, youmust ensure that the port is not in use by another process.

o The port of the HTTPS listener. Select a Linux port number between 1024
and 65534 (usually 8443)

For more information about ports, see the Support Matrix document available
from the Support Site
(https://softwaresupport.hp.com/group/softwaresupport/home) or from
the Installation DVD).

Currency: Default Currency. The currency to use as default.

Tip: If you are using the Project and Portfolio Management or the Asset
Manager applications as data sources, make sure that you select the currency
corresponding to the currency defined in these applications.

The supported currencies follow ISO 4217
(http://www.iso.org/iso/home/standards/currency_codes.htm).

Default: USD - US Dollar

For details, see "Currency" on page 113.
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Enter the Application\DWH Configuration Authentication Details

Page

1. The Application\DWH Configuration Authentication Details panel is displayed.

2. Enter the relevant field number and answer the request with the relevant value.
Proceed through all the fields, and then enter n.

Set Glassfish
Administrator
Password:

The user password for glassfish.

Note:

o The passwordmust be at least 8 characters in length, andmust contain a
combination of three of the following categories: upper case English
characters (A-Z), lower case English characters (a-z), numbers (0-9), and
non-alphanumeric characters (for example: ! $ #% andmore).

o The password is case-sensitive.

o You can change the glassfish password using theMaintenance Tool.

Important:Save the values of the parameters in this page. TheGlassfish
Administrator password is also used to log on to the ITBA Maintenance tool.
The Application authentication password is also used as your ITBA logon
credentials.

For details, seeMaintenance Tool in theAdministrator Guide.

Re-enter the password for the administrator.

Set ITBA
Logon User
Name:

The user name for the BA administrator. Use this user to log on to Business
Analytics.

The password for the BA administrator.
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Set
ITBA Logon
Password:

Note:

o The passwordmust be at least 8 characters in length, andmust contain a
combination of three of the following categories: upper case English
characters (A-Z), lower case English characters (a-z), numbers (0-9), and
non-alphanumeric characters (for example: ! $ #% andmore).

o The password is case-sensitive.

Re-enter the administrator password.
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Usage Hub Page

1. The Usage Hub choose panel is displayed.

2. Then:

o Enter 1, enter false, and n if you do not want to track the license usage.

o Enter 1, enter true, and n if you want to track the license usage.

Enter 1, enter the IT number of the Usage hub host, and enter n.
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Install Summary Page

1. The Install Summary panel is displayed and shows a summary of the selected configuration.
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2. Enter:

o n to start the installation.

o p to correct the configuration.

Note: The passwords that you entered in the installation pages are encrypted and are not
displayed in the Install Summary page.
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Installation is Running

1. The Install in Progress panel is displayed and indicates that the installation is running:
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Install Complete

1. The Install in Progress panel is displayed and shows that the installation was successful.

2. Enter f to complete the installation.

3.
Tip: Make sure to install the Supervisor. For details, see "Install the Supervisor After the
Installation" on page 96.
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GUI Installation
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Introduction

1. Create a user or use an existing user.

Note: Make sure you are not using the root user to perform the installation.

2. Log on to the Linux server where you want to install ITBA.

3. Download the ITBA-10.10.XXX.tar.gz file from the Support Site
(https://softwaresupport.hpe.com/group/softwaresupport/home?lang=en-US) and save it in your
Linux target directory.

Note: Make sure the installation target directory has adequate disk space. For details, see
Support Matrix.

Note: Make sure that the path to the target directory does not include blank spaces, brackets
(or), or single quotes (').

4. Run the tar -zxvf ITBA-10.10.XXX.tar.gz command to unzip the ITBA-10.10.XXX.tar.gz file.

5. Go to the Linux user path directory where you unzipped the installation file, and run ./install.sh -g
or sh install.sh -g.

The installation wizard opens.
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6. Click Next.
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7. In the License Agreement page, click Agree.
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Enter the Vertica Database Server Details

In the page:

1. Enter the Vertica database details.

Host
Name

The fully qualified domain name (FQDN) or IP address of the server hosting the
Vertica database.

To configure Vertica load balancing, see the section “Connection Load Balancing”
in the Vertica Administrator’s guide at
https://my.vertica.com/docs/7.1.x/PDF/HP_Vertica_7.1.x_
AdministratorsGuide.pdf.

Port The port of the server listener. Change this value to connect to a non-default
database instance on the server.

For more information about ports, see the Support Matrix document available from
the Support Site
(https://softwaresupport.hp.com/group/softwaresupport/home) .

Database
Name

The name of the Vertica database instance that is used as the data warehouse.

Make a note of the Vertica database name as youmay need it when installing
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other components.

For details, see Database Naming Conventions.

Login
Name

The name of the user used to log on to the Vertica database.

Password The password of user used to log on to the Vertica database.

2. Click Run Check.

The system verifies that the server answers all needed requirements.

If the check passes with no errors, theNext button is enabled.

3. Click Next.
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Enter the Database Scheme Names

By default, the fields in the page already include the default names.

1. Enter your own values or keep the defaults:

Source Staging Scheme name The name of the source staging scheme.

Default: dws

Target Staging Scheme name The name of the target staging scheme.

Default: dwst

Target Scheme name The name of the target scheme.

Default: dwt

Application Scheme name The name of the application scheme.

Default: BA

Result Scheme name The name of the result scheme.

Default: dbo

Extension Scheme name The name of the extension scheme.
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Default: ext

After entering the DB schemes, theNext button is enabled.

2. Click Next.
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Load Your License

In the page:

1. Load the permanent/temporary license or use the evaluation license:

o For an evaluation License:
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o For a permanent or a Viewer license:

Load a Power Named
User license or
temporary license

Select to load one of the following license types:

o Power Named User License. Has no expiry date and is
loaded once during the installation.

o Temporary. Has an expiry date. On expiration, a new license
must be loaded.

To load a license, click Load, Navigate to the license file provided
by your supplier, and then click Load License.

Get an evaluation license Select to load a one-off 60-day evaluation license. The remaining
valid period of the license is displayed.

For details, see Update Licenses in theAdministrator Guide.

After selecting the relevant license, theNext button is enabled.

2. Click Next.
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Enter the SAP BOE Server Settings

In the page:

1. Click Next if you do not need to connect to BOE at this time.

When you do not select the option:
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2. Select Connect to an existing BOE server, if you want to integrate with an existing BOE server.

Once you select this option, the rest of the fields become enabled. Enter the BOE server details (if
needed):

Connect to an
existing
SAP BusinessObjects
Enterprise server

Select to connect to an existing SAP BusinessObjects Enterprise
server.

Note: Only specific SAP BOE versions are supported. For details,
see the Support Matrix.

The Support Matrix is available from the Support Site
(https://softwaresupport.hp.com/group/softwaresupport/home).

BOE Server name The name of the server on which is located the SAP BusinessObjects
Enterprise that you want to connect with Business Analytics is
installed.

CMS Port The port number of the CMS listener (usually 6400).

For more information about ports, see the Support Matrix document
available from the Support Site
(https://softwaresupport.hp.com/group/softwaresupport/home).

Administrator User The user name for the SAP BusinessObjects Enterprise
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Name administrator.

Use this user to log on to SAP BusinessObjects Enterprise.

Administration
Password

The SAP BusinessObjects Enterprise Administrator password. This
password is used only to log on to SAP BusinessObjects Enterprise.

This password is used only to log on to SAP Business Object
Enterprise.

SSO Shared Secret The path to the file that includes the SSO shared secret password.
The shared secret password is used to authenticate communications
with the SAP BusinessObjects BI platform or later server. If trusted
authentication is configured, the shared secret entered is validated
against the SAP BusinessObjects server. If trusted authentication is
not configured, the entered shared secret is configured on the SAP
BusinessObjects BI platform server.

Authentication
scheme

secEnterprise. The default authenticationmethod for the SAP
BusinessObjects BI platform. It is automatically enabled when you
first install the system, and it cannot be disabled. When you add and
manage users and groups, the platform maintains the user and group
information within its database.

If you prefer to create distinct accounts and groups for use with the BI
platform, or if you have not already set up a hierarchy of users and
groups in a third-party directory server, you have to do it manually.

Tomcat port The BOE Tomcat port used to display the BOE reports in Scorecard
(usually 8080). For more information about ports, see the Support
Matrix document.

The Support Matrix is available from the Support Site
(https://softwaresupport.hp.com/group/softwaresupport/home).

Import BA license to
SAP BOE

Select to import the ITBA license to SAP BOE.

3. After entering the BOE server details (if needed), theNext button is enabled.

4. Click Next.
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Enter the Application\DWH Configuration Details

In the page:

1. Enter the relevant application and DWH configuration details:

Period
Dimension

First Year. The first year in the period dimension is the first year used when
automatically populating DataWarehouse tables with yearly, quarterly,
monthly, weekly and daily records.

Change the First Year value by clicking the up or down arrows.

Last Year. The last year in the period dimension is the last year used when
automatically populating DataWarehouse tables with yearly, quarterly,
monthly, weekly and daily records.

Change the Last Year value by clicking the up or down arrows.

Note: The Last Year must not be lower than the current year.

For more information, see Settings - DataWarehousein theAdministrator
Guide.
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First fiscal month of the year. The first fiscal month of the year in your
organization.

First day of the week. The day of the week you want to set as the first day.

Note: First day of the week

In DataWarehouse, the first day of the week is set during the installation,
and the Period tool is using it as an input to build PERIOD_DIM days,
weeks, months, andmore, as well as relevant hierarchies.

After the administrator has installed DataWarehouse, the administrator
selects the designated first-day-of-week. If a data source has a different
first-day-of-week definition, the administrator should be aware that for
weekly periodicity, the linkage to the period key uses the Data
Warehouse week definition and not the data source week definition.

Data related
configuration:

Time Zone. The DataWarehouse time zone used when consolidating the
data extracted from the data sources.

Web Server
configuration:

o The port of the HTTP listener. Select a Linux port number between 1024
and 65534.

Note: If you want to use the default HTTP port in the Business Analytics
installation, youmust ensure that the port is not in use by another process.

o The port of the HTTPS listener. Select a Linux port number between 1024
and 65534 (usually 8443)

For more information about ports, see the Support Matrix document available
from the Support Site
(https://softwaresupport.hp.com/group/softwaresupport/home) or from
the Installation DVD).

Currency: Default Currency. The currency to use as default.

Tip: If you are using the Project and Portfolio Management or the Asset
Manager applications as data sources, make sure that you select the
currency corresponding to the currency defined in these applications.

The supported currencies follow ISO 4217
(http://www.iso.org/iso/home/standards/currency_codes.htm).

Default: USD - US Dollar

After entering the details, theNext button is enabled.

2. Click Next.
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Enter the Application\DWH Configuration Authentication Details

Page

1. Enter the relevant application configuration authentication details:

Glassfish
authentication
parameters:

The user password for glassfish.

Note:

o The passwordmust be at least 8 characters in length, andmust contain a
combination of three of the following categories: upper case English
characters (A-Z), lower case English characters (a-z), numbers (0-9), and
non-alphanumeric characters (for example: ! $ #% andmore).

o The password is case-sensitive.

o You can change the glassfish password using theMaintenance Tool.

Important:Save the values of the parameters in this page. TheGlassfish
Administrator password is also used to log on to the ITBA Maintenance tool.
The Application authentication password is also used as your ITBA logon
credentials.
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For details, seeMaintenance Tool in theAdministrator Guide.

Re-enter the password for the administrator.

Application
authentication
parameters:

The user name for the BA administrator. Use this user to log on to Business
Analytics.

The password for the BA administrator.

Note:

o The passwordmust be at least 8 characters in length, andmust contain a
combination of three of the following categories: upper case English
characters (A-Z), lower case English characters (a-z), numbers (0-9), and
non-alphanumeric characters (for example: ! $ #% andmore).

o The password is case-sensitive.

Re-enter the administrator password.

After entering the details, theNext button is enabled.

2. Click Next.
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Enter the Usage Hub Settings

In the page, you can select one of the following actions:

l Click Next directly.
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l Select Configure the Usage Hub settings, enter the relevant values, and then click Next.

Configure the Usage
Hub Settings

Select the option to allow you to configure the Usage Hub settings
during the installation.

Usage Hub Host The hostname or IP number of the server on which the Usage Hub is
installed.
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Install Summary Page

In the page, a summary of the selected configuration is displayed. Click Next to start the installation.
Click Back to correct the configuration.

The passwords that you entered in the installation pages are encrypted and are not displayed in the
Install Summary.
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Installation is Running

The page that indicates that the installation is running is as follows:
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Install Complete
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The installation is complete when the following page is displayed.
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You can now launch the ITBA application by following the steps listed on the page.
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Click Complete to complete the installation.

Tip: Make sure to install the Supervisor. For details, see "Install the Supervisor After the
Installation" on the next page
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Install the Supervisor After the Installation
The IT Business Analytics Supervisor monitors whether the ITBA server processes are up and running.

Note that youmust perform this procedure when you have installed ITBA silently using one of the
following:

l <ITBA_Target_directory>/install.sh –s (for a silent installation)

l <ITBA_Target_directory>/install.sh –c (for a console installation)

l <ITBA_Target_directory>/install.sh –g (for a GUI installation).

Contact HP Software Support Online web site (https://softwaresupport.hpe.com) if themonitor
cannot start the Supervisor process.

Tasks

This section includes:

Enable the Supervisor for the ITBA System 96

Start/Stop ITBA 97

Log file 97

Enable the Supervisor for the ITBA System

As a root user, youmust enable the Supervisor for the ITBA system by running the following steps after
the installation is completed.

1. Enable the Supervisor for the ITBA system:

a. Open a Linux console (bash) and input command su root.

b. Run $HPBA_HOME/supervisor/configure/install_supervisor_conf.sh. It automatically
starts ITBA.

2. Check ITBA running status:
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a. Run su hpba

b. Run $HPBA_HOME/supervisor/bin/hpba-status.sh

Start/Stop ITBA

1. Run $HPBA_HOME/supervisor/bin/hpba-start.sh

2. Run $HPBA_HOME/supervisor/bin/hpba-stop.sh

Log file 

If necessary, check the log file for ITBA start/stop process in the
$HPBA_HOME/supervisor/log/ directory.
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Configure the Linux Port

Note:When you redirect your ports, you lose the extra protection from the low ports; any user on
your machine can bind to port 8080.

If you want to redirect port 80 to port 8080, proceed as follows:

Run as root:

# iptables -t nat -A PREROUTING -p tcp --dport 80 -j REDIRECT --to-port 8080
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How to Use Your Own Certificate?
Every time you log on, a warning about non-trusted certificate is issued with a certificate error. You can
use your own certificate. To upload your own certificate to ITBA, perform the steps below on the ITBA
server.

Note:

l The Certificate and the Key should be in PEM format.

l By default, a self-signed certificate was used during the installation of ITBA. However, it is not
recommended to use self-signed certificates in production environments as they may negate
the benefits of end-to-end security by decreasing the ability of a user to detect aman-in-the-
middle (MITM) attack.

1. Replace the server certificate and the server private key in the web server.

a. Obtain the server certificate and the server private key in PEM format. The procedure below
refers to them as server.cer.pem and server.key.pem respectively.

b. Copy the server.cer.pem and server.key.pem to $HPBA_HOME/conf/keys.

c. Update the web server configuration to use those files.

d. Edit $HPBA_HOME/webserver/conf/extra/httpd-ssl.conf.

e. In httpd-ssl.conf, replace btoa.host.hp.com.key.pem with server.key.pem.
Replace btoa.host.hp.com.cert.pem with server.cer.pem.

f. Save changes.

2. Configure the Java truststore to trust the CA that issued your server certificate.

a. Obtain the CA certificate in PEM format. The procedure below refers to it as ca.cer.pem.

b. Copy the ca.cer.pem to $HPBA_HOME/conf/keys.

c. Import ca.cer.pem into the Java truststore.

d. Use the CMD to access $HPBA_HOME/jdk/jre/bin.

e. Execute keytool -import -trustcacerts -alias ca.cer.pem -keystore ../lib/security/cacerts
-file $HPBA_HOME/conf/keys/ca.cer.pem.

f. Enter the keystore password when prompted (default password is changeit).

g. When prompted whether to trust the certificate, write y.
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3. Restart the ITBA application using the command $HPBA_HOME/supervisor/bin/hpba-
restart.sh.
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How to Upload .BIAR Files
SomeWebi reports are supported in ITBA. You can view these reports in the relevant ITBA Dashboard
pages.  They are provided in the CSA CAP and the CSA_DemoCAP.

You can view these reports through the Dashboard pages that are linked to the BOE server.

WEBI Report CAP .BIAR File

Resource Usage and Utilization for Consumer

Resource Usage and Utilization for Resource
Supplier Manager

Amazon EC2 Instance Usage and Utilization

Billing Statement for Cloud Services

Billing Statement for Consumer Organization Admin

Showback Detail For Cloud Services

Showback Detail for Consumer

Showback for Consumer

CSA CAP Cloud_Billing.biar

Showback for Consumer Demo

Showback Detail for Consumer Demo

Resource Usage and Utilization for Resource
Supplier Manager Demo

Resource Usage and Utilization for Consumer
Demo

Showback Detail for Cloud Services Demo

Amazon EC2 Instance Usage and Utilization Demo

Billing Statement for Cloud Services Demo

CSA_Demo
CAP

Cloud_Billing_Demo.biar

Only the CSA CAP reports are imported into the BOE server automatically if you have configured the
BOE connection while installing ITBA.

If you did not configure the BOE connection while installing ITBA, or if you want to view BO reports in
the ITBA application, perform the configuration as in "Optional - Install BOE Client onWindows Server"
on page 33 or "Optional - Install BOE on a Linux Server" on page 16, then configure the Vertica Driver
as shown in "Optional - Install the Vertica Driver in the BOE Server and the BOE Client Server" on page
39and then run the below steps.

To import theCloud_Billing.biar or theCloud_Billing_Demo.biar:
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1. Copy the .biar files from the ITBA server:

$HPBA_HOME /ContentPacks/CSA/INBUILT/BI/BOE/Cloud_Billing.biar

$HPBA_HOME /ContentPacks/DEMO_CONTENT/INBUILT/BI/BOE/Cloud_Billing_
Demo.biar

2. Log on to the SAP BusinessObjects Central Management Console (CMC) at: http://<BOE_
Server_IP>:8080/BOE/CMC.

3. Click Promotion Management.

4. Click Promotion Jobs > Import > Import file.
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5. Click Choose File and select the relevant .biar file.

6. In theDestination field, select Login to a New CMS.
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7. Enter the BOE server IP number or server name, user name, and password, and then click Login.

8. Click Create to create promotion job.

9. Click Promote.
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10. Click Promote.

The .biar file is uploaded successfully.

11. Log on to theUniverse Design Tool from the BOE Client.
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12. Click Tools > Connections…. Edit the relevant connection.

If you are uploading the CSA CAP, edit XS_DWH_JDBC.

If you are uploading the CSA_DemoCAP, edit XS_EXT_JDBC.

13. Enter the relevant connectionmessage of the Vertica server and click Next.
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14. Click Next > Finish > Close.

The import of the .biar files is complete.

15. By default, the application schema name is BA, the extension schema name is ext, and the
database name is xsvertica. If the customer server settings are different, change the as shown
below.

a. Click File > Import…, and select theCloud Billing universe folder.
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b. Select Cloud Billing and click OK.
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c. Right-click the relevant table, and select Rename Table.

d. In theOwner field enter the correct application schema name and in theQualifier field enter
the correct database name.

e. After modifying all the relevant tables as shown above, click File > Export….
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f. Click OK to upload the changes to BOE the server.

16. Proceed in the sameway for the Cloud Billing Demo universe folder.
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Installation Logs
Installation logs and ITBA environment information help you quickly understand what went wrong with
the installation process. The installation logs are archived by the installation process in many different
paths of the installation directory. For example, $HPBA_
HOME/glassfish/glassfish/domains/BTOA/logs/, or $HPBA_HOME/webserver/httpd/logs/. The
ITBA environment information (for example, ITBA version, database name) is collected in the
BAInfo.xls file.

To concentrate all the installation logs and ITBA environment information into one location, use the Log
Toolkit. For details, see Log Toolkit in theAdministrator Guide.
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Uninstall ITBA
To uninstall ITBA, use the root user, go to $HPBA_HOME, and run the following command:
./uninstall.sh
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Currency
The currency should be as follows:

Note: The field is case insensitive.

Value Currency

USD US Dollar

AED U.A.E. dirham

ANG Netherlands Antillian guilder

ARS Argentine peso

AUD Australian Dollar

BSD Bahamian dollar

BHD Bahraini dinar

BDT Bangladesh taka,

BGN Bulgarian Lev

BWP Botswanan pula

BRL Brazilian real

BND Brunei dollar

CAD Canadian Dollar

CHF Swiss Franc

CLP Chilean peso

CNY Chinese yuan renminbi

COP Colombian peso

CZK Czech koruna,

DKK Danish krone

EGP Egyptian pound

EUR Euro

FJD Fiji dollar
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GBP British Pound

GHS Ghana cedi,

GTQ Guatemala quetzal

HKD Hong Kong Dollar

HNL Honduras lempira

HUF Hungarian forint

HRK Croatian kuna,

IDR Indonesian rupiah

ILS Israeli shekel

IRR Iranian rial

IQD Iraqi dinar

INR Indian Rupee,

ISK Iceland krona

JMD Jamaican dollar

JPY Japanese Yen

KRW South Korean won

KZT Kazakhstan tenge,

KWD Kuwaiti dinar

LKR Sri Lankan rupee

LVL Latvian lats

LTL Lithuanian litas

LYD Libyan dinar,

MAD Moroccan dirham

MMK Myanmar kyat

MUR Mauritius rupee

MXN Mexican peso

MYR Malaysian ringgit,

NOK Norwegian krone
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NPR Nepalese rupee

NZD New Zealand Dollar

OMR Omani rial

PKR Pakistan rupee,

PAB Panamanian balboa

PEN Peruvian sol nuevo

PHP Philippine peso

PLN Polish zloty

QAR Qatari riyal,

RON Romanian new leu

RSD Serbian dinar

RUB Russian Ruble

SAR Saudi riyal

SEK Swedish Krona,

SGD Singapore Dollar

THB Thai Baht

TND Tunisian dinar

TRY Turkish lira

TTD Trinidad and Tobago dollar

TWD Taiwan new dollar

VEF Venezuelan bolivar fuerte

VND Vietnamese dong

XAF CFA franc BEAC,

XDR Special Drawing Right

XPF CFP franc

ZAR South African Rand
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Time Zones
The time zones are as follows:

Note: The field is case-insensitive.

ACT

AET

Africa/Abidjan

Africa/Accra

Africa/Addis_Ababa

Africa/Algiers

Africa/Asmera

Africa/Bamako

Africa/Bangui

Africa/Banjul

Africa/Bissau

Africa/Blantyre

Africa/Brazzaville

Africa/Bujumbura

Africa/Cairo

Africa/Casablanca

Africa/Ceuta

Africa/Conakry

Africa/Dakar

Africa/Dar_es_Salaam

Africa/Djibouti

Africa/Douala
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Africa/El_Aaiun

Africa/Freetown

Africa/Gaborone

Africa/Harare

Africa/Johannesburg

Africa/Kampala

Africa/Khartoum

Africa/Kigali

Africa/Kinshasa

Africa/Lagos

Africa/Libreville

Africa/Lome

Africa/Luanda

Africa/Lubumbashi

Africa/Lusaka

Africa/Malabo

Africa/Maputo

Africa/Maseru

Africa/Mbabane

Africa/Mogadishu

Africa/Monrovia

Africa/Nairobi

Africa/Ndjamena

Africa/Niamey

Africa/Nouakchott

Africa/Ouagadougou

Africa/Porto-Novo

Africa/Sao_Tome
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Africa/Timbuktu

Africa/Tripoli

Africa/Tunis

Africa/Windhoek

AGT

America/Adak

America/Anchorage

America/Anguilla

America/Antigua

America/Araguaina

America/Aruba

America/Asuncion

America/Atka

America/Barbados

America/Belem

America/Belize

America/Boa_Vista

America/Bogota

America/Boise

America/Buenos_Aires

America/Cambridge_Bay

America/Cancun

America/Caracas

America/Catamarca

America/Cayenne

America/Cayman

America/Chicago

America/Chihuahua
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America/Cordoba

America/Costa_Rica

America/Cuiaba

America/Curacao

America/Danmarkshavn

America/Dawson

America/Dawson_Creek

America/Denver

America/Detroit

America/Dominica

America/Edmonton

America/Eirunepe

America/El_Salvador

America/Ensenada

America/Fort_Wayne

America/Fortaleza

America/Glace_Bay

America/Godthab

America/Goose_Bay

America/Grand_Turk

America/Grenada

America/Guadeloupe

America/Guatemala

America/Guayaquil

America/Guyana

America/Halifax

America/Havana

America/Hermosillo
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America/Indiana/Indianapolis

America/Indiana/Knox

America/Indiana/Marengo

America/Indiana/Vevay

America/Indianapolis

America/Inuvik

America/Iqaluit

America/Jamaica

America/Jujuy

America/Juneau

America/Kentucky/Louisville

America/Kentucky/Monticello

America/Knox_IN

America/La_Paz

America/Lima

America/Los_Angeles

America/Louisville

America/Maceio

America/Managua

America/Manaus

America/Martinique

America/Mazatlan

America/Mendoza

America/Menominee

America/Merida

America/Mexico_City

America/Miquelon

America/Monterrey
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America/Montevideo

America/Montreal

America/Montserrat

America/Nassau

America/New_York

America/Nipigon

America/Nome

America/Noronha

America/North_Dakota/Center

America/Panama

America/Pangnirtung

America/Paramaribo

America/Phoenix

America/Port-au-Prince

America/Port_of_Spain

America/Porto_Acre

America/Porto_Velho

America/Puerto_Rico

America/Rainy_River

America/Rankin_Inlet

America/Recife

America/Regina

America/Rio_Branco

America/Rosario

America/Santiago

America/Santo_Domingo

America/Sao_Paulo

America/Scoresbysund
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America/Shiprock

America/St_Johns

America/St_Kitts

America/St_Lucia

America/St_Thomas

America/St_Vincent

America/Swift_Current

America/Tegucigalpa

America/Thule

America/Thunder_Bay

America/Tijuana

America/Tortola

America/Vancouver

America/Virgin

America/Whitehorse

America/Winnipeg

America/Yakutat

America/Yellowknife

Antarctica/Casey

Antarctica/Davis

Antarctica/DumontDUrville

Antarctica/Mawson

Antarctica/McMurdo

Antarctica/Palmer

Antarctica/Rothera

Antarctica/South_Pole

Antarctica/Syowa

Antarctica/Vostok
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Arctic/Longyearbyen

ART

Asia/Aden

Asia/Almaty

Asia/Amman

Asia/Anadyr

Asia/Aqtau

Asia/Aqtobe

Asia/Ashgabat

Asia/Ashkhabad

Asia/Baghdad

Asia/Bahrain

Asia/Baku

Asia/Bangkok

Asia/Beirut

Asia/Bishkek

Asia/Brunei

Asia/Calcutta

Asia/Choibalsan

Asia/Chongqing

Asia/Chungking

Asia/Colombo

Asia/Dacca

Asia/Damascus

Asia/Dhaka

Asia/Dili

Asia/Dubai

Asia/Dushanbe
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Asia/Gaza

Asia/Harbin

Asia/Hong_Kong

Asia/Hovd

Asia/Irkutsk

Asia/Istanbul

Asia/Jakarta

Asia/Jayapura

Asia/Jerusalem

Asia/Kabul

Asia/Kamchatka

Asia/Karachi

Asia/Kashgar

Asia/Katmandu

Asia/Krasnoyarsk

Asia/Kuala_Lumpur

Asia/Kuching

Asia/Kuwait

Asia/Macao

Asia/Macau

Asia/Magadan

Asia/Makassar

Asia/Manila

Asia/Muscat

Asia/Nicosia

Asia/Novosibirsk

Asia/Omsk

Asia/Oral
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Asia/Phnom_Penh

Asia/Pontianak

Asia/Pyongyang

Asia/Qatar

Asia/Qyzylorda

Asia/Rangoon

Asia/Riyadh

Asia/Riyadh87

Asia/Riyadh88

Asia/Riyadh89

Asia/Saigon

Asia/Sakhalin

Asia/Samarkand

Asia/Seoul

Asia/Shanghai

Asia/Singapore

Asia/Taipei

Asia/Tashkent

Asia/Tbilisi

Asia/Tehran

Asia/Tel_Aviv

Asia/Thimbu

Asia/Thimphu

Asia/Tokyo

Asia/Ujung_Pandang

Asia/Ulaanbaatar

Asia/Ulan_Bator

Asia/Urumqi
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Asia/Vientiane

Asia/Vladivostok

Asia/Yakutsk

Asia/Yekaterinburg

Asia/Yerevan

AST

Atlantic/Azores

Atlantic/Bermuda

Atlantic/Canary

Atlantic/Cape_Verde

Atlantic/Faeroe

Atlantic/Jan_Mayen

Atla ATLANTIC_MADEIRA(ntic/Madeira

Atlantic/Reykjavik

Atlantic/South_Georgia

Atlantic/St_Helena

Atlantic/Stanley

Australia/ACT

Australia/Adelaide

Australia/Brisbane

Australia/Broken_Hill

Australia/Canberra

Australia/Darwin

Australia/Hobart

Australia/LHI

Australia/Lindeman

Australia/Lord_Howe

Australia/Melbourne
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Australia/North

Australia/NSW

Australia/Perth

Australia/Queensland

Australia/South

Australia/Sydney

Australia/Tasmania

Australia/Victoria

Australia/West

Australia/Yancowinna

BET

Brazil/Acre

Brazil/DeNoronha

Brazil/East

Brazil/West

BST

Canada/Atlantic

Canada/Central

Canada/East-Saskatchewan

Canada/Eastern

Canada/Mountain

Canada/Newfoundland

Canada/Pacific

Canada/Saskatchewan

Canada/Yukon

CAT

CET

Chile/Continental
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Chile/EasterIsland

CNT

CST

CST6CDT

CTT

Cuba

EAT

ECT

EET

Egypt

Eire

EST

EST5EDT

Etc/GMT

Etc/GMT+0

Etc/GMT+1

Etc/GMT+10

Etc/GMT+11

Etc/GMT+12

Etc/GMT+2

Etc/GMT+3

Etc/GMT+4

Etc/GMT+5

Etc/GMT+6

Etc/GMT+7

Etc/GMT+8

Etc/GMT+9

Etc/GMT-0
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Etc/GMT-1

Etc/GMT-10

Etc/GMT-11

Etc/GMT-12

Etc/GMT-13

Etc/GMT-14

Etc/GMT-2

Etc/GMT-3

Etc/GMT-4

Etc/GMT-5

Etc/GMT-6

Etc/GMT-7

Etc/GMT-8

Etc/GMT-9

Etc/GMT0

Etc/Greenwich

Etc/UCT

Etc/Universal

Etc/UTC

Etc/Zulu

Europe/Amsterdam

Europe/Andorra

Europe/Athens

Europe/Belfast

Europe/Belgrade

Europe/Berlin

Europe/Bratislava

Europe/Brussels
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Europe/Bucharest

Europe/Budapest

Europe/Chisinau

Europe/Copenhagen

Europe/Dublin

Europe/Gibraltar

Europe/Helsinki

Europe/Istanbul

Europe/Kaliningrad

Europe/Kiev

Europe/Lisbon

Europe/Ljubljana

Europe/London

Europe/Luxembourg

Europe/Madrid

Europe/Malta

Europe/Minsk

Europe/Monaco

Europe/Moscow

Europe/Nicosia

Europe/Oslo

Europe/Paris

Europe/Prague

Europe/Riga

Europe/Rome

Europe/Samara

Europe/San_Marino

Europe/Sarajevo
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Europe/Simferopol

Europe/Skopje

Europe/Sofia

Europe/Stockholm

Europe/Tallinn

Europe/Tirane

Europe/Tiraspol

Europe/Uzhgorod

Europe/Vaduz

Europe/Vatican

Europe/Vienna

Europe/Vilnius

Europe/Warsaw

Europe/Zagreb

Europe/Zaporozhye

Europe/Zurich

GB

GB-Eire

GMT

GMT0

Greenwich

Hongkong

HST

Iceland

IET

Indian/Antananarivo

Indian/Chagos

Indian/Christmas
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Indian/Cocos

Indian/Comoro

Indian/Kerguelen

Indian/Mahe

Indian/Maldives

Indian/Mauritius

Indian/Mayotte

Indian/Reunion

Iran

Israel

IST

Jamaica

Japan

JST

Kwajalein

Libya

MET

Mexico/BajaNorte

Mexico/BajaSur

Mexico/General

Mideast/Riyadh87

Mideast/Riyadh88

Mideast/Riyadh89

MIT

MST

MST7MDT

Navajo

NET
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NST

NZ

NZ-CHAT

Pacific/Apia

Pacific/Auckland

Pacific/Chatham

Pacific/Easter

Pacific/Efate

Pacific/Enderbury

Pacific/Fakaofo

Pacific/Fiji

Pacific/Funafuti

Pacific/Galapagos

Pacific/Gambier

Pacific/Guadalcanal

Pacific/Guam

Pacific/Honolulu

Pacific/Johnston

Pacific/Kiritimati

Pacific/Kosrae

Pacific/Kwajalein

Pacific/Majuro

Pacific/Marquesas

Pacific/Midway

Pacific/Nauru

Pacific/Niue

Pacific/Norfolk

Pacific/Noumea
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Pacific/Pago_Pago

Pacific/Palau

Pacific/Pitcairn

Pacific/Ponape

Pacific/Port_Moresby

Pacific/Rarotonga

Pacific/Saipan

Pacific/Samoa

Pacific/Tahiti

Pacific/Tarawa

Pacific/Tongatapu

Pacific/Truk

Pacific/Wake

Pacific/Wallis

Pacific/Yap

PLT

PNT

Poland

Portugal

PRC

PRT

PST

PST8PDT

ROK

Singapore

SST

SystemV/AST4

SystemV/AST4ADT
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SystemV/CST6

SystemV/CST6CDT

SystemV/EST5

SystemV/EST5EDT

SystemV/HST10

SystemV/MST7

SystemV/MST7MDT

SystemV/PST8

SystemV/PST8PDT

SystemV/YST9

SystemV/YST9YDT

Turkey

UCT

Universal

US/Alaska

US/Aleutian

US/Arizona

US/Central

US/East-Indiana

US/Eastern

US/Hawaii

US/Indiana-Starke

US/Michigan

US/Mountain

US/Pacific

US/Pacific-New

US/Samoa

UTC
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VST

W-SU

WET

Zulu
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Installation Guide (IT Business Analytics 10.10)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a webmail client, and
send your feedback to SW-Doc@hpe.com.

We appreciate your feedback!
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